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Câble d’interface PC

Pour commencer
1. Veuillez télécharger la version la plus récente du logiciel 

Solinst Levelogger depuis www.solinst.com/downloads, 
puis installer le logiciel sur votre ordinateur. 

2. Raccordez la tête de puits LevelVent Wellhead et 
l’enregistreur au câble ventilé :  

Cavité de positionnement 
dans les connecteurs du 

câble ventilé

Ergot de positionnement dans 
les connecteurs de la Wellhead 

et de l’enregistreur

LevelVent 
Logger

Câble 
ventilé

Tête de puits 
LevelVent

Alignez la cavité de positionnement du connecteur du câble 
ventilé avec l’ergot de positionnement du connecteur de la 
Wellhead. Poussez avec précaution les connecteurs l’un 
vers l’autre. Tournez le connecteur du câble légèrement 
jusqu’à ce que vous perceviez un petit clic lorsque le 
raccordement correct se fait.  

Ne serrez l’accouplement que tout en maintenant la tête de 
puits et le câble ventilé immobiles. Serrez le raccord jusqu’à ce 
qu’il s’enclenche. Aucun filet ne doit être visible au niveau du 
raccord de la tête de puits. Ne tordez pas le câble ventilé ou la 
tête de puits.  

Seulement 
tourner 

l’accouplement

Tenir le câble ventilé 
immobile

Tenir la tête de 
puits immobile

Suivez la même procédure lors de la connexion de 
l’enregistreur au câble ventilé. 

3. Raccordez le câble USB d’interface PC au haut de la tête de 
puits LevelVent Wellhead. Branchez le câble d’interface PC 
sur votre ordinateur. 
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Fenêtre Paramètres de l’enregistreur de données

1. Lancez le logiciel Levelogger.
2. Sélectionnez le port COM approprié pour l’appareil connecté dans le menu déroulant 

situé dans la partie centrale.
3. Cliquez sur l’icône « Retrieve Settings » (Récupérer les réglages). Cela récupère 

et affiche les valeurs actuelles des paramètres de programmation pour l’appareil 
LevelVent 5 connecté. 

4. Vous pouvez maintenant personnaliser votre LevelVent 5, y compris l’ID du projet, 
l’emplacement, la fréquence et le débit d’échantillonnage, et la programmation des heures 
de démarrage et d’arrêt

Programmation d’un LevelVent 5

Remarque :  Assurez-vous que l’enregistreur de données LevelVent 5 utilise la version la 
plus récente du firmware et que vous utilisez la dernière version du logiciel. 
Veuillez consulter le site Web de Solinst ou utiliser la fonction de mise à jour 
du logiciel pour obtenir de l’aide.

              Conseil : Si un certain nombre d’enregistreurs LevelVent 5 doivent être 
programmés avec les mêmes entrées, cliquez sur l’icône « Save Default Setting » 
(Sauvegarder les réglages par défaut) pour créer un modèle.

Remarque :  Vous pouvez cliquer sur le  intégré au logiciel 
pour obtenir une brève explication de la fonction 
correspondante, par ex. Com Port, Datalogger Zero, 
Slate Mode, Time Synchronization, etc.
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Téléchargement et utilisation des données
1. Cliquez sur l’onglet « Data Control » (Contrôle des données) pour accéder à la 

fenêtre « Data Control » (Contrôle des données).  
Cette fenêtre se compose de trois sections : les paramètres de configuration de 
l’enregistreur, les données sous forme tabulaire et les données sous forme graphique.

2. Pour télécharger des données à partir d’un enregistreur LevelVent connecté, 
sélectionnez l’icône « Download Data » (Télécharger les données). Il existe quatre 
options pour le téléchargement de données. Ces lignes sont : « All Data » 
(Toutes les données), « Append Download » (Ajouter les données), « Partial 
Download » (Téléchargement partiel) et « Download and Delete Files » (Télécharger 
et supprimer des fichiers). Les données seront présentées sous forme de tableau et 
de graphique.

3. Pour sauvegarder des données, cliquez sur l’icône « Save Data » (Sauvegarder les 
données), puis saisissez le nom désiré pour le fichier sauvegardé.

4. Pour exporter le fichier, afin de les utiliser dans d’autres programmes, cliquez sur 
l’icône « Export » (Exporter). Le fichier peut être exporté sous le format  
*.csv ou *.xml.

Remarque :  Pour changer le répertoire par défaut des données téléchargées, utilisez 
le menu « Configuration » (Configuration) dans la partie supérieure de la 
fenêtre du logiciel. Sélectionnez « Application Settings » (Paramètres de 
l’application), puis saisissez ou naviguez à un autre dossier. Cliquez sur OK.

Démarrage et arrêt du LevelVent 5
1. Si vous le souhaitez, saisissez une heure de démarrage et/ou d’arrêt futur. Pour 

commencer l’enregistrement immédiatement, ne saisissez pas d’heure de début 
future et cliquez sur l’icône “Start Now”.

Remarque :  Lorsque l’icône “Start” est sélectionnée, une fenêtre s’ouvre pour indiquer 
la quantité de mémoire disponible. En sélectionnant “Oui”, vous ignorez 
le message et vous démarrez le collecteur de données immédiatement. La 
sélection de “Non” vous donne la possibilité d’accéder à l’onglet “Contrôle 
des données” pour télécharger et/ou supprimer des fichiers de données à 
l’aide de l’option “Télécharger et supprimer des fichiers”, afin de libérer de la 
mémoire.

Remarque :  Le répertoire par défaut pour le téléchargement et la sauvegarde des 
données est le dossier de données :  
<C:\Program\Files\Solinst\Levelogger 4_6\Data>. Les données sont 
sauvegardées dans un fichier de données .xle.

Conseil :  Les options « ‘Future Start » (Démarrage programmé) et « Future Stop » (Arrêt 
programmé) sont parfaites pour la synchronisation de la collecte des données de 
plusieurs enregistreurs LevelVent.

2. Lorsque “Oui” est sélectionné, tous les paramètres sont appliqués au LevelVent 5 
et il commencera l’enregistrement à l’heure spécifiée.

3. Pour arrêter le LevelVent 5 immédiatement, cliquez sur l’icône “Stop Now”.
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Fenêtre « Data Control » (Contrôle des données)

Visualisation en temps réel
L’onglet « Real Time View » (Visualisation en temps réel) fournit une mesure à l’écran des 
données enregistrées par l’enregistreur connecté. Un taux de visualisation est configuré de 
manière indépendante de la période d’enregistrement du LevelVent 5, de manière à ne pas 
interférer avec l’enregistrement interne en cours. Pour effectuer un relevé à tout moment, 
cliquez sur  et le relevé sera ajouté aux données affichées. Les données peuvent être 
exportées et sauvegardées.

Compensation des données
Cliquez sur l’onglet « Data Wizard » (Assistant des données) pour accéder à la fenêtre 
« Data Wizard » (Assistant des données). Dans cette fenêtre, l’assistant vous guide à travers 
les ajustements manuels des données (altitude ou conversion de la hauteur d’eau) et les 
ajustements des paramètres (unités, altitude, densité) sur vos fichiers de données ouverts. Il est 
possible de compenser plusieurs fichiers de données LevelVent 5 à la fois.

Conseil :  Manual Data Adjustments (Ajustements manuels des données) permet d’utiliser 
des mesures manuelles du niveau de l’eau pour ajuster vos relevés de profondeur 
jusqu’au niveau de l’eau.

Conseil :  Les formats de fichiers *.csv et *.xml sont pris en charge et peuvent être 
importés par la plupart des tableurs et des programmes de bases de données. 

  Les graphiques de données peuvent être exportés en format *.bmp ou *.png en 
cliquant sur File > Export > Graph.
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Mesure sur le terrain avec LevelVent 5
Plages du LevelVent 5
Les modèles LevelVent 5 sont prévus pour une profondeur d’immersion spécifique. Le choix 
du modèle dépend de la précision du niveau requis et de la profondeur d’immersion. Ce qui est 
important, c’est que votre sélection doit être basée sur les fluctuations maximales prévues du 
niveau d’eau. 

Modèle 
LevelVent 5

Profondeur 
d’immersion Précision 

M5 5 m (16,4 pi) ± 0,3 cm (0,010 pi)

M10 10 m (32,8 pi) ± 0,5 cm (0,016 pi)

M20 20 m (65,6 pi) ± 1 cm (0,032 pi)

Conseil : Pour ajuster toutes 
les mesures dans votre fichier 
LevelVent à la profondeur 
de l’eau en dessous d’un 
tubage de puits (d), mesurez 
manuellement le niveau de 
l’eau à l’aide d’une sonde de 
niveau d’eau. Cette mesure 
doit correspondre, en termes 
de données et de moment, 
avec un enregistrement 
LevelVent. Utilisez cela 
comme un point de référence 
dans l’option « Manual Data 
Adjustment » (Ajustement 
manuel des données) dans 
l’Assistant des données du 
logiciel Levelogger.

Références fondamentales pour les mesures

Vérification des relevés
La meilleure recommandation 
est de comparer les relevés 
LevelVent (L) avec une valeur 
de profondeur par rapport 
au niveau d’eau (d) mesurée 
manuellement (à l’aide d’un 
appareil de mesure du niveau 
d’eau).

Les enregistreurs 
LevelVent 5 détectent 
la pression. Un tube 
de ventilation vers 
la surface permet 
d’éliminer les effets 
barométriques (+B) sur 
le capteur de pression 
(-B).

Les enregistreurs LevelVent 5 
fournissent des lectures (L) de la 
pression réelle de l’eau juste au-
dessus du point zéro du capteur 
de pression.
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Notes de terrain LevelVent 5

Avant le déploiement
Assurez-vous de faire ce qui suit:
• Programmez votre enregistreur LevelVent 5  à l’aide du logiciel Levelogger, en saisissant 

les informations correctes pour l’identification du projet, le mode de mémoire, le mode 
d’échantillonnage, la programmation, etc.

• Programmez une heure de démarrage programmée lorsque vous serez au bureau ou lancez 
l’enregistreur LevelVent 5 sur le terrain à l’aide du logiciel Levelogger pour PC et d’un 
ordinateur portable, ou de l’App Levelogger et l’interface App Solinst Levelogger 5. 

• Si vous le souhaitez, utilisez la fonction de mise à zéro de l’enregistreur de données dans 
le logiciel Levelogger pour mettre l’enregistreur à zéro (voir le Guide de l’utilisateur des 
enregistreurs de données ventilés pour plus de détails).

• Déterminez la profondeur du trou de forage, afin de vous assurer que l’enregistreur 
LevelVent 5 ne touche pas le fond du puits (éviter l’immersion dans les sédiments)

• Déterminez les niveaux d’eau minimum et maximum prévus, les enregistreurs LevelVent 5 
devant rester immergés pendant toute la période de surveillance.

Remarque :  Il est conseillé de synchroniser les horlogers de tous les enregistreurs 
LevelVent 5 utilisés pour un projet donné.

Remarque :  L’enregistreur LevelVent 5 peut résister à une surpression de 2 fois la valeur 
de la plage maximale prévue. Par exemple, un modèle M10 peut supporter 
une fluctuation de 20 mètres (60 pieds) et continuer à mesurer la pression. 
Cependant, la précision en dehors de la plage prévue n’est pas garantie.

Conseil :  Il est recommandé de mesurer manuellement le niveau de l’eau avant 
d’installer un enregistreur LevelVent 5, peu de temps après son installation, 
périodiquement pendant la période de surveillance et à la fin de la période de 
mesure. Utilisez ces mesures pour vérifier les relevés du LevelVent 5 et pour 
les ajustements de données plus tard. Veillez à effectuer des mesures manuelles 
aussi près que possible des relevés programmées du LevelVent.

Remarque :  La longueur du câble ventilé ne doit pas être confondue avec la profondeur 
de déploiement, car il peut y avoir un peu de mou dans le câble, 
particulièrement lorsque vous utilisez un support de suspension

• Utilisez une sonde de niveau d’eau Solinst modèle 101 ou 102 pour mesurer manuellement 
la profondeur jusqu’au niveau de l’eau qui sera utilisée pour vérifier les relevés du LevelVent 
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Après le déploiement 
Assurez-vous de faire ce qui suit:
• Mesurez manuellement la profondeur jusqu’au niveau de l’eau après que le puits est 

stabilisé (environ 10 minutes)

• Effectuez une autre mesure manuelle de la distance à la surface de l’eau juste avant de 
retirer l’enregistreur LevelVent du puits

Déploiement
• L’enregistreur LevelVent 5 est conçu pour être installé de manière pratique à l’aide d’un 

ensemble de couvercle de puits Solinst de 5 cm (2 pouces) (un adaptateur de 10 cm 
(4 pouces) est disponible). Cependant, d’autres installations sont acceptables si des 
précautions adéquates sont prises et les recommandations sont suivies. 

• Un support de suspension est fourni avec chaque ensemble de couvercle de puits Solinst de 
5 cm (2 pouces), afin de fixer le câble ventilé à la tête de puits Wellhead.

• L’ensemble de couvercle de puits Solinst de 5 cm (2 pouces) permet d’effectuer une 
mesure manuelle de la profondeur jusqu’au niveau de l’eau, sans perturber l’enregistreur 
LevelVent 5 de sa position au fond du trou.

• Les têtes de puits ont un indice de protection IP64 (résistantes à la poussière et aux 
éclaboussures) et ne doivent donc jamais être immergées. Il est possible de les fixer à 
l’intérieur d’un boîtier, mais dans ce cas, le boîtier doit être ventilé pour égaliser la pression 
atmosphérique. 

• Veillez à ne pas laisser tomber votre enregistreur LevelVent 5 dans l’eau, abaissez-le 
soigneusement. Ne l’installez pas dans des endroits où des « coups de bélier » ou des « ressauts 
hydrauliques » (augmentation importante et très soudaine de la pression) peuvent se produire. 

• Veillez à ne pas entailler ou plier le câble ventilé pendant l’installation (utilisez un rayon de 
courbure de 25 mm (1 pouce) maximum par mesure de précaution).

Remarque :  Pour des conseils, des mises en garde ou d’autres informations sur l’installation 
dans des applications ou des environnements différents, reportez-vous à la version 
la plus récente du Guide d’utilisation des enregistreurs de données ventilés.
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Communication sur le terrain 
Il existe trois moyens de communiquer avec un LevelVent sur le terrain : 
• Un câble d’interface PC raccordé à la tête de puits LevelVent Wellhead permet la 

communication avec le logiciel Levelogger sur un ordinateur portable sur le terrain

• La Levelogger 5 App Interface se connecte directement à la tête de puits LevelVent 
Wellhead, permettant la communication avec votre appareil intelligent à l’aide de 
l’application Levelogger App de Solinst

• L’unité de lecture Solinst (SRU) se connecte directement à la tête de puits LevelVent, ce 
qui vous permet de visualiser des relevés instantanés du niveau d’eau, d’enregistrer des 
journaux en temps réel et de télécharger des données.

• Le DataGrabber 5 se connecte directement à la tête de puits LevelVent Wellhead, vous 
permettant de télécharger des données sur une clé USB

Câble d’interface PC

App Levelogger et Levelogger 5 
App Interface

DataGrabber 5SRU



- 10 -

Options de surveillance à distance
Solinst propose des options de communication à distance sans fil par télémétrie cellulaire. 
Voir les guides d’utilisation séparés pour plus de détails.
• Le LevelSender 5 utilise la communication cellulaire 4G pour envoyer les données du 

LevelVent 5 à distance à votre PC de la station d’accueil et à votre appareil intelligent par 
e-mail ou SMS. S’insère dans un puits de 2”.

• Les systèmes de télémétrie STS 5 utilisent la communication cellulaire 4G pour envoyer les 
données de niveau d’eau à distance des enregistreurs LevelVent 5 à un PC Home Station. 
Connectez jusqu’à quatre enregistreurs.

• Le système de télémétrie RRL 5 (Remote Radio Link) utilise la communication radio pour 
envoyer les données de niveau d’eau à distance des enregistreurs LevelVent 5 vers un PC 
de la station domestique ou une station distante STS 5.

Remarque : Pour communiquer avec des enregistreurs de données ou des systèmes de 
télémétrie tiers, Solinst propose l’enregistreur de données de niveau d’eau ventilé 
AquaVent 5 qui peut communiquer en utilisant les protocoles SDI-12 ou MODBUS. 
Voir la fiche technique du modèle 3500.

4

+

+

Télémétrie STS 5

LevelSender 5

Câble de lecteur 
LevelSender 5

Câble de lecteur 
STS 5
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Entretien
Comme avec tout projet de surveillance, vous devez sélectionner l’équipement approprié et 
définir un programme d’entretien basé sur l’environnement spécifique à votre application. 
Pour s’assurer que le tube d’aération reste sec, les enregistreurs LevelVent 5 et les têtes 
de puits Wellhead renferment des produits desséchants permanents et des membranes 
hydrophobes au niveau des raccordements au câble ventilé, de sorte qu’il n’est pas nécessaire 
de les remplacer. Voir notre bulletin technique sur la conception, l’utilisation et la maintenance 
des câbles ventilés pour plus de détails.

Autres conseils pour l’entretien :
• Remplacez les joints toriques au niveau des raccords du câble ventilé sur l’enregistreur 

LevelVent 5 et la tête de puits Wellhead.

• Le nettoyage des raccords garantit une bonne étanchéité. Il est possible d’utiliser un coton-
tige pour retirer toute trace d’humidité ou de débris sur les connecteurs.

• Lorsque des raccords ne sont pas utilisés, couvrez-les toujours avec des cache-poussière. 

• Lorsque vous ne les utilisez pas, enroulez toujours l’enregistreur LevelVent 5 et le câble 
ventilé sur leur bobine pour les conserver.

• Nettoyez l’enregistreur LevelVent 5, si nécessaire. 

• Pour s’assurer que le tube de ventilation est sec avant tout déploiement ou stockage, Solinst 
propose un raccord d’aération du câble ventilé qui permet de souffler de l’azote dans le 
tube.

Remarque :  Reportez-vous au Guide d’utilisation des enregistreurs de données ventilés 
pour d’autres conseils d’entretien. 

Remarque :  Il est possible d’utiliser la protection Solinst contre l’encrassement biologique 
pour protéger le LevelVent 5 contre l’encrassement biologique sur le capteur 
de pression. 
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Logiciel Levelogger pour PC :
1. Vous devez disposer de privilèges d’administrateur pour installer le logiciel sur un 

ordinateur.
2. Le système d’exploitation Windows 10 prend en charge le logiciel Levelogger.

Guide de diagnostic des anomalies

Si votre enregistreur LevelVent 5 ne communique pas avec le logiciel 
Levelogger pour PC ou si vous obtenez un message d’erreur de 
communication :
1. Vérifiez les connexions du câble ventilé à l’enregistreur LevelVent 5 et à la tête de puits 

Wellhead. Assurez-vous qu’elles sont alignées correctement et qu’il n’y a pas des résidus 
ou de débris dans le raccord.

2. Assurez-vous que vous utilisez le câble USB d’interface PC correct pour vous connecter à 
l’ordinateur. 

3. Vérifiez que le câble USB d’interface PC est raccordé au même port de communication 
que celui choisi dans la partie supérieure de la fenêtre principale du logiciel Levelogger.

4. Essayez de communiquer avec un autre enregistreur LevelVent 5, une tête de puits 
Wellhead, un câble ventilé ou un câble USB d’interface PC. 

5. Essayez d’utiliser un autre ordinateur.
6. Si le problème persiste, contactez Solinst.

Remarque :  À des fins de diagnostic, vous pouvez installer l’extrémité du câble ventilé 
portant le numéro de série au connecteur de surface de la tête de puits 
Wellhead. 

Compatibilité du câble ventilé
Les câbles ventilés de style ancien (vendus avant le 16/4/21 avec des numéros de série 
inférieurs à 506326) ne sont pas compatibles avec les Wellheads LevelVent 5 de style plus 
récent (vendus après le 14/4/21 avec des numéros de série de 495959 et plus) et les loggers 
(vendus après le 5/4/21) sans une petite modification de l’utilisateur - contactez Solinst pour 
les instructions. 

Les câbles ventilés de style plus récent sont compatibles avec toutes les versions des Wellheads 
et des loggers LevelVent - veuillez noter qu’après avoir serré à fond le connecteur du nouveau 
câble ventilé, le joint torique externe d’un logger ou d’un Wellhead ancien est visible et qu’il est 
normal qu’il ne repose pas contre le connecteur.
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